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NEW QUESTION 1

- (Exam Topic 1)

You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked
Live.

Box 2: Select Restore on the previous version of the app. Restore an app from your account

Open powerapps.com, and then click or tap Apps in the left navigation bar.

Near the right edge, click or tap the info icon for the app that you want to restore.

Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 2

- (Exam Topic 2)

You need to create the solution assets.

What should you use to create the visualizations? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: PowerBI Desktop

The Sales dashboard must reside in the Sales channel and must include information about active quotes, sales pipeline, and year-to-date sales KPIs for sales
guotas by region.

PowerBI Desktop to support many data source. Box 2: PowerBI Desktop or Power Bl Service on

A dashboard that shows a capacity Heat map by month as well as expected sales that are likely to close for the next month.

Both support visualizations. Reference:

https://docs.microsoft.com/en-us/power-bi/fundamentals/service-service-vs-desktop
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NEW QUESTION 3
- (Exam Topic 2)
You need to implement logic in the app for lost sales. What should you do?

A. Create a business process flow.

B. Define a business rule for the Sales Log edit form.

C. Set the required field property of the Won/Lost field to Required.

D. Create a formula for the Description field that uses the Update function.

Answer: B

Explanation:
Scenario: Requests for quotes are currently stored in a Sales Log workbook. The workbook includes the following information:

Status of the Request for Quote (RFQ) with the values of Won, Lost, No Bid, and Cancelled Salespeople often do not set status of RFQs in the Sales Log to Won
when a sale is closed and the customer

purchase order is received.

You can create business rules and recommendations to apply logic and validations without writing code or creating plug-ins. Business rules provide a simple
interface to implement and maintain fast-changing and commonly used rules.

Business rules defined for an entity apply to both canvas apps and model-driven apps if the entity is used in the app.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 4

- (Exam Topic 2)

You need to configure the system to meet the requirements.

What should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: 1:N

Scenario: A sortable listing of all in-process jobs from the Job Setup table, by customer, start date, and product.

Box 2: User or Team owned

Scenario: Employees must only be able to access their own time tracking records from the app.

User or team: Data belongs to a user or a team. Actions that can be performed on these records can be controlled on a user level.
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/types-of-entities

NEW QUESTION 5

- (Exam Topic 3)

You are configuring a new Common Data Service environment by using the Power Apps Maker portal. You need to create an entity that uses the prefix xyz.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-entity

NEW QUESTION 6

- (Exam Topic 3)

You plan to create apps for a company.

You need to identify the Power Platform tools required.

What should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You may
need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Canvas App

Box 2: Model-driven app

Model-driven app design is a component-focused approach to app development. Model-driven app design doesn't require code and the apps you make can be
simple or very complex. Unlike canvas app development where the designer has complete control over app layout, with model-driven apps much of the layout is
determined for you and largely designated by the components you add to the app.

Box 3: Power Automate

Power Automate is a service that helps you create automated workflows between your favorite apps and services to synchronize files, get notifications, collect
data, and more.

Box 4: Power Virtual Agents bot

When you create bots with Power Virtual Agents, you author and edit topics.

NEW QUESTION 7

- (Exam Topic 3)

Each maker at a company has a separate Common Data Service environment. You are customizing a canvas app. You create two new entities in your
environment.

You are leaving for a vacation. Another maker will continue customizing the app in your absence.

You need to transfer the work to the other maker and ensure that you can work on the updated app when you return from your vacation.

What should you export?

A. ununmanaged solution that includes all customizations
B. the default solution

C. a managed solution that includes all customizations

D. the app

Answer: A

Explanation:

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 8

- (Exam Topic 3)

A company has a Common Data Service custom entity that stores customer account data. You need to create a relationship between the custom entity and the
Account entity. Which two tools can you use? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Power Platform Admin center

B. Power Apps solution explorer

C. Power Apps Maker portal

D. SQL Server Management Studio
E. Visual Studio Code

Answer: BC

Explanation:

There are two designers you can use to create and edit 1:N (one-to-many) or N:1 (many-to-one) relationships:

You can create and edit 1:N (one-to-many) or N:1 (many-to-one) entity relationships in Power Apps portal

You can create and edit create and edit 1:N (one-to-many) or N:1 (many-to-one) entity relationships using solution explorer
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-1n-relationships
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NEW QUESTION 9

- (Exam Topic 3)

You need to set the value for a global variable named RunningTotal to 5 and navigate to the previous screen named MainScreen.
Which formula should you use?

A. UpdateContext( { RunningTotal: 5 } ); Navigate( MainScreen, ScreenTransition.Cover, RunningTotal );
B. If( Value(TextBox1.Text) >= 0, (Set( RunningTotal, 5); Back();), Color.Green )

C. UpdateContext( { RunningTotal:5 } ); Back()

D. Set( RunningTotal, 5 ); Back();

Answer: D

Explanation:

You set the value of the global variable with the Set function. Set( MyVar, 1) sets the global variable MyVar to a value of 1.

Use the Back and Navigate function to change which screen is displayed. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-variables https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-navigate

NEW QUESTION 10

- (Exam Topic 3)

An administrator plans to create and deploy dashboards for use only by sales associates. The dashboards will display the current sales pipeline, open cases,
recent major wins, and key opportunities by postal code. Sales associates must be able to act on the specific data displayed in dashboards.

You need to create the dashboards.

Which type of dashboards should you create? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: User

Type of dashboard: If you want your dashboards to be available across the organization and do not want to manage the access levels at a more detailed level, you
might want to create an organization-owned dashboard. However, if you are concerned about the access privileges and security of your dashboard, consider
creating a user-owned dashboard where you have more control on who can access it.

Box 2: Single-stream

The single-stream dashboards display real-time data over one stream based on an entity view or queue. The single-stream dashboards are typically helpful to Tier
2 service leads or managers, who monitor fewer, but more complex or escalated cases.

Reference:

https://docs.microsoft.com/en-us/powerapps/developer/model-driven-apps/create-dashboard https://docs.microsoft.com/en-us/powerapps/maker/model-driven-
apps/configure-interactive-experience-dashbo

NEW QUESTION 10
- (Exam Topic 3)
You have the following Common Data Service entities: BusinessContracts and BusinessAccounts. You need to configure an N:N relationship between the two

entities.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the

correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Open the relationship tab of the BusinessContracts entity. View entity relationships

From the Power Apps portal, select either Model-driven or Canvas design mode. Select Data > Entities and select the entity that has the relationships you want to
view. With the Relationships tab selected, you can select the following views:

Step 2: Select Add relationship.. Create relationships

While viewing entity relationships, in the command bar, select Add relationship and choose Many-to-many. Step 3: Select the BusinessAccounts entity as the
related entity.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-nn-relationships-portal

NEW QUESTION 11

- (Exam Topic 3)

A company uses Power Automate and Power Apps to streamline business processes. You need to use Al Builder to analyze customer reviews of the company’s
products.

In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Step 1: Connect data to the model.
First create an Al Builder form processing model for the customer reviews you want to process.

Step 2: Train the model. Step 3: Publish the model.

Step 4: Use the model in a Power Automate flow.

Once you train and publish the model, create a solution-aware flow in Power Automate. Reference:
https://powerapps.microsoft.com/en-us/blog/introducing-simplified-ai-builder-experience-in-power-automate/

NEW QUESTION 15

- (Exam Topic 3)

You are designing a canvas app that will be used by all users including users who have vision impairments. Which outcome is achieved by each action? To
answer, drag the appropriate outcomes to the correct actions.

Each outcome may be used once, more than once, or not at all. You may need to drag the split bar between

panes or scroll to view content.

NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/sv-se/powerapps/maker/canvas-apps/accessible-apps

NEW QUESTION 18

- (Exam Topic 3)

You create a custom field on the Account entity.

Members of TeamA must have full access to the field. Members of TeamB must have no access to the field. You need to configure security.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Enable field security for the field

Step 2: Create a field security profile and set all the permissions for the custom attribute to Yes. Step 3: Add TeamA to the field security profile.

Note: Field-level security is available for the default fields on most out-of-box entities, custom fields, and custom fields on custom entities. Field-level security is
managed by the security profiles. To implement field-level security, a system administrator performs the following tasks.

Enable field security on one or more fields for a given entity.

Associate one more existing security profiles, or create one or more new security profiles to grant the appropriate access to specific users or teams.

NEW QUESTION 19

- (Exam Topic 3)

You create a canvas app for technicians at a computer store. You assign technicians cases to work on. The technicians update cases at the end of customer site
visit.

The manager wants the technicians to sell warranties to the customers. If a customer agrees to purchase a warranty, technicians use the canvas app to
immediately alert the sales team, and then the technician records details about the warranty into the app.

You need to create a flow to alert the sales team. Which type of trigger should you use?

A. Flow button for mobile
B. Power Apps

C. Office 365 Outlook

D. Common Data Service

Answer: A

Explanation:

Create a button flow to run routine tasks by simply tapping a button. Customize your flow by allowing the user to provide specific details that will be used when the
flow runs.

Note: There are many repetitive tasks that we all wish we could run with just a tap of a button. For example, you may need to quickly email your team to remind
them to join the daily team sync, or you may want to start a new Visual Studio Codespaces build of your code base after you've been notified that there are no
more checkins planned for the day. Button flows allow you to accomplish these and many other tasks simply by tapping a button on your mobile device.
Reference:

https://docs.microsoft.com/en-us/power-automate/button-flow-with-user-input-tokens

NEW QUESTION 20

- (Exam Topic 3)

You create an app with multiple screens.

Test users report that the size and type of gallery displayed on each screen are different. You must improve the consistency for the app screens.

You need to create a reusable gallery that displays information based on the current record.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

NOTE: More than one order of answer choices is correct. You will receive credit for any of the correct orders you select.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Add a gallery control Add a gallery to a blank screen

* 1. On the Insert tab, select Gallery, and then select Vertical.

* 2. On the Properties tab of the right-hand pane, open the Items list, and then select your Gallery Step 2: Add a screen

Add a gallery in a screen

* 1. On the Home tab, select New screen > List screen.

A screen that contains a Gallery control and other controls, such as a search bar, appears. Step 3: Add an input property

Input property is how a component receives data to be used in the component. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-gallery https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/create-component

NEW QUESTION 23

Your Partner of IT Exam visit - https://www.exambible.com



We recommend you to try the PREMIUM PL-100 Dumps From Exambible
exam blb|@ https://www.exambible.com/PL-100-exam/ (153 Q&AS)

Relate Links

100% Pass Your PL-100 Exam with Exambible Prep Materials

https://www.exambible.com/PL -100-exam/

Contact us

Weare proud of our high-quality customer service, which servesyou around the clock 24/7.

Viste - https.//www.exambible.com/

Your Partner of IT Exam visit - https://www.exambible.com


https://www.exambible.com/PL-100-exam/
https://www.exambible.com/
http://www.tcpdf.org

